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Abstract

Our laboratories have used genetically engineered mouse models (GEMMs) to assess genetic 

contributions to skeletal diseases such as osteoporosis and osteoarthritis. Studies on the genetic 

contributions to OA are often done by assessing how GEMMs respond to surgical methods that 

induce symptoms modeling OA. Here, we will describe protocols outlining the induction of 

experimental OA in mice as well as detailed descriptions of methods for analyzing skeletal 

phenotypes using micro-computerized tomography and skeletal histomorphometry.
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1 Introduction

The analysis of skeletal phenotypes of genetically modified mice has contributed to 

advancements of our knowledge about skeletal development and disease and has provided 

the foundation for the development of several FDA-approved treatments for bone-related 

diseases. Our laboratories have used genetically engineered mouse models (GEMMs) to 

assess genetic contributions to skeletal diseases such as osteoporosis and osteoarthritis. 

Studies on the genetic contributions to OA are often done by assessing how GEMMs 

respond to surgical methods that induce symptoms modeling OA. The generation of 
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GEMMs is applicable to all tissue and disease types and discussion of methodologies for 

their generation is available in many other contexts [1, 2]. Here, we focus on several 

methods specific for generating and analyzing skeletal phenotypes in mice. We first describe 

the generation of an OA-like model via surgical destabilization of the medial meniscus. We 

will then describe the evaluation of skeletal phenotypes via micro-computerized tomography 

(microCT) and histomorphometry.

2 Materials

2.1 Surgical Destabilization of the Medial Meniscus (DMM)

1. Experimental mice of the same strain divided into DMM surgery group (n ≥ 5) 

and sham surgery control group (n ≥ 5). Age of mice should be decided 

according to the goal of experiments, but generally mice at or older than 3 

months of age are optimal as their skeletal maturity is reached. All mice should 

be housed in a gnotobiotic facility, according to the National Research Council’s 

Guide and Institutional Animal Care and Use Committee-approved protocols for 

the care and use of experimental animals (see Note 1).

2. Isoflurane machine: VetEquip Tabletop laboratory animal anesthesia system 

(VetEquip # 901820).

3. Isoflurane (Piramal # NDC 66794–017-25).

4. Surgical microscope (Leica # M651).

5. Veterinary operating table heated mat (Peco # Mediheat V500).

6. 9 mm Wound forceps and clips (Reflex # RS-9260, RS-9262).

7. Wound clip remover (Reflex # RS-9263).

8. Hair removal lotion.

9. Alcohol antiseptic wipes.

10. Micro-iris scissors.

11. Micro-surgical knife (#3 handle and #10/ #11 blade).

12. Sharppoint 15° 5 mm blade micro-surgical knife.

13. Epinephrine (1:1000 dilution).

14. Amoxicillin (20 mg/kg).

2.2 Osteoarthritis (OA) Histology

1. Histological tissue cassette case.

2. Surgical scissors.

3. Tweezer.

1.Male mice are more susceptible to developing DMM-induced osteoarthritis [10] thus considered suitable materials for such 
experiments, but the selection of mouse genders should accommodate the goals of specific studies.
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4. Deionized water.

5. Ethanol 70%, 80%, 90%, 95%, 100%.

6. Neutral buffered formalin (NBF) 10%.

7. Formic acid 5%.

8. Xylene.

9. Paraffin (Paraplast X-tra).

10. Oven.

11. Stock solution A: 10 g hematoxylin, 500 mL 80% ethanol.

12. Stock solution B: 20 g ferric chloride, 475 mL distilled water, 5 mL hydrochloric 

acid (36.5–38%).

13. Modified Weigert’s Iron Hematoxylin: equal volume stock solutions A and B 

(see Note 2).

14. Acid-alcohol 1.0%: 5 mL hydrochloric acid (36.5–38%), 495.0 mL 70% ethanol.

15. Acetic acid 1.0%: 5.0 mL glacial acetic acid, 495 mL distilled water.

16. Fast Green 0.08%: 0.20 g Fast Green, 250.0 mL distilled water.

17. Safranin O 1%: 2.5 g Safranin O, 250 mL distilled water.

2.3 Microcomputed Tomography

All standards, equipment, and software for scanning and analysis are produced by Bruker 

microCT, Kontich, Belgium and Micro Photonics Inc., Allentown, PA.

1. Neutral buffered formalin (NBF) 10%.

2. Deionized (DI) water.

3. Ethanol (EtOH) 70%.

4. Gauze cut to length of the sample.

5. Plastic conical.

6. Bruker Skyscan 1172.

7. Skyscan 1172 (Scanning software) Version 1.5.26.0.

8. Software NRecon Version 1.7.4.6.

9. GPUReconServer Version 1.7.4.2.

10. Data Viewer Version 1.5.6.3 software.

2.Mix equal volume of stock solutions A and B to make the Modified Weigert’s Iron Hematoxylin working solution right before use. 
The working solution has a shelf life of about 1 week when stored in dark.
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2.4 Bone Mineral Density Calibration

1. Bone mineral density standards 0.25 and 0.75.

2. CT Analyzer Version 1.18.8.0 software.

2.5 Trabecular Analysis of Microcomputed Tomography Images

1. CT Analyzer Version 1.18.8.0 software.

2.6 Cortical Analysis of Microcomputed Tomography Images

1. CT Analyzer Version 1.18.8.0 software.

2.7 Bone Modeling

1. CTvol Version 2.3.2.0 software.

2.8 Fluorochrome Labeling of Bone

1. Calcein Green 1.0% stock solution: In a 50 mL conical tube, dissolve 400 mg 

NaHCO3 in 20 mL of saline (0.9% NaCl). Slowly add 200 mg calcein (Sigma-

Aldrich # C0875). Calcein will foam if added quickly. pH to 7.4 using 1 N 

NaOH or 1 N HCl and filter sterilize into evacuated 20 mL glass vial. Wrap in 

foil and store at 4 °C (see Note 3).

2. Calcein Green 0.10% working solution: Dilute the Calcein Green 1.0% stock 

solution in saline. Pipette 2.0 mL of 1% calcein stock and 18.0 mL of saline. 

Wrap in foil and store at 4 °C (see Note 4).

3. Alizarin Complexone 2.5% stock solution: In a 50 mL conical tube, dissolve 400 

mg NaHCO3 in 20 mL of saline (0.9% NaCl). Slowly add 500 mg alizarin 

complexone (Sigma-Aldrich # A3882). Alizarin will foam if added quickly. pH 

to 7.4 using 1 N NaOH or 1 N HCl and filter sterilize into evacuated 20 mL glass 

vile. Wrap in foil and store at 4 °C.

4. Alizarin Complexone 0.20% working solution: Dilute 2.5% stock solution with 

saline to 0.2%. Pipette 0.8 mL of 2.5% alizarin stock and 9.2 mL of saline.

5. Demeclocycline HCL 0.75% working solution: In a sterile 200 mL bottle, 

dissolve 1 g demeclocycline hydrochloride (Sigma-Aldrich # D6140) in 133 mL 

of sterile saline (0.75% solution). Place on a rocker plate and rock gently for 20 

min. Aliquot into light-proof 1.5 mL tubes and store at −20 °C.

2.9 Fixation

1. DI water.

2. Ethanol 70%.

3. Neutral Buffered Formalin (NBF) 10%.

3.Wrap in foil to prevent exposure as the solution is light sensitive.
4.Stock solution is diluted to the 10 mg/kg recommended dose for injecting mice.
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2.10 Infiltration

1. Dremel hand tool.

2. Automated tissue processor.

3. Ethanol 70%, 95%, 100%.

4. Fisherbrand Histocassette Tissue Cassette.

5. Infiltration solution: 85% Methyl methacrylate (MMA) and 15% dibutyl 

phthalate (DBP).

6. Methyl methacrylate (MMA) 100%.

7. NBF 10%.

8. Rapid Infiltration Processor (RIP).

9. Xylene.

10. Embedding molds.

11. Glass culture tubes.

2.11 Embedding and Cross-Sectioning

1. 600-grit Sandpaper.

2. Allen wrench.

3. Binder clips.

4. DI water.

5. Embedding solution: 85% MMA, 15% DBP, and 0.5% Perdadox 16.

6. Eukitt Mounting Medium Electron Microscopy Sciences # 15320.

7. Extech Labcut 150.

8. 3”×.006”× ½ Diamond Wafering Blade.

9. Glass culture tubes with rubber stoppers.

10. Glass slides.

11. Lab Armor Bead Bath.

12. Micrometer.

13. Paper towel.

14. Sonicator.

15. Small weight.

2.12 MMA Embedding and Coronal Sectioning

1. Automatic rotary microtome.

2. Bead bath.

Foxa et al. Page 5

Methods Mol Biol. Author manuscript; available in PMC 2021 March 05.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



3. Clamps.

4. Coating solution: 85 mL DI water, 1 g gelatin powder, and 15 mL glycerol 

incubate the solution at 42 °C in a water bath until dissolved or visible particles 

are no longer visible (see Note 5).

5. Cutting solution: 10 mL 70% ethanol, 90 mL distilled water, and 2 drops of soap 

(see Note 6).

6. Embedding solution: 85% MMA, 15% DBP, and 0.5% Perdadox 16.

7. Ethanol 70%, 75%.

8. Forceps.

9. Fine tip paint brush.

10. Glass slides.

11. Kimwipes.

12. MetaServ 250 Single Grinder/Polisher.

13. Paperclips.

14. Paper towels.

15. Petri dish.

16. Plastic film.

17. Rubber roller.

18. Silicone stopper.

19. Oven.

20. Prefabricated mold for embedding.

21. Acetone.

22. Cellusolve.

23. DI water.

2.13 Golder’s Trichrome Stain

1. Wiegert’s Iron Hematoxylin: Prepare fresh by combining 50 mL Wiegert’s 

Solution A and 50 mL Wiegert’s Solution B.

2. Ponceau Fuchsin solution A: 1 g Ponceau, 100 mL DI water.

3. Ponceau Fuchsin solution B: 1 g Acid fuchsin, 100 mL DI water.

4. Ponceau Fuchsin stock solution: 30 mL Ponceau fuchsin solution A, 10 mL 

ponceau fuchsin solution B.

5.Once prepared, the coating solution is stable at room temperature for 1 week.
6.Once prepared, the solution is stable at room temperature until expiration date of the ethanol lot.
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5. Acetic acid 1%.

6. Ponceau Fuchsin working solution: Dilute 10 mL ponceau fuchsin stock solution 

in 150 mL 0.2% acetic acid.

7. Phosphotungstic Acid (PTA) Orange G: Combine and filter 2 g Orange G, 4 g 

phosphotungstic acid, and 100 mL DI water.

8. Light Green: combine and filter 0.2 g Light Green, 0.2 mL acetic acid, and 100 

mL DI water.

9. DI water.

10. Ventana Symphony tissue processor.

2.14 Paraffin Embedding and Sectioning

1. DI water.

2. Embedding center (Leica EG1150H).

3. Ethylenediaminetetraacetic acid (EDTA) 10%: pH 7.4.

4. Ethanol 70%, 80%, 95%, 100%.

5. Fisherbrand Histocassette Tissue Cassette.

6. Forceps.

7. Glass slides.

8. Kimwipes.

9. NBF 10%.

10. Oven.

11. Paraffin/tissue infiltration media.

12. Steel microtome knife.

13. Xylene.

14. Tissue processor.

15. Water bath.

2.15 TRAP Stain

1. Sigma-Aldrich product 387-A: Acid Phosphatase, Leukocyte (TRAP) kit.

2. Aqueous mounting media.

3. Glass slides.

4. Glass coverslips.

2.16 Slide Imaging

1. ET-DAPI/FITC/Texas Red filter set (Chroma product # 69002).
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2. Leica Aperio AT2 High Volume, Digital Whole Slide Scanning.

3. Lumen Dynamics X-Cite Series 120 Q.

4. QImaging QIClick Digital CCD Camera.

5. Zeiss Axio Imager.A2.

6. BIOQUANT OSTEO 19.2.6. software.

2.17 Histomorphometry

1. BIOQUANT OSTEO 19.2.6 software.

3 Methods

3.1 DMM Surgery

The methods described below that we utilize in the laboratory have been developed and 

optimized based on several previous studies [3-6]. Operate the anesthesia machine according 

to the VetEquip user guide and operating manual (http://www.vetequip.com/pdfs/LAAS%20

Manual.pdf). DMM surgery should be performed on both knees of each individual mice of 

the DMM group, and sham surgery will be performed to another group of mice for controls. 

Surgery should be carried out with standard sterile techniques, i.e., preoperative instrument 

sterilization and disinfection, and cleansing of incision area.

1. Anesthetize the mice with 4% isoflurane and 1 L/min oxygen in the VetEquip 

tabletop laboratory animal anesthesia chamber.

2. Once the mice are anesthetized, transfer them to a mask and maintain with 3% 

isoflurane and 1 L/min oxygen.

3. Place the mice on a veterinary operating table heated mat to maintain body 

temperature during surgery.

4. To bare the incision area, apply hair removal lotion on the medial side of knee for 

3 min. Then wipe with alcohol antiseptic wipes.

5. In order to expose the medial side of stifle joint capsule, use a micro-iris scissor 

or a micro-surgical knife to open a 3 mm longitudinal incision through the skin 

and subcutaneous tissue over the distal patella to proximal tibial plateau.

6. Expose medial meniscotibial ligament (MMTL), which anchors medial meniscus 

(MM). During the process, avoid destabilizing patellar tendon, medial collateral 

ligament, and articular cartilage.

7. To prevent bleeding that may block the vision for performing transection, one 

drop of 0.1% epinephrine can be applied at the incision site (optional).

8. Under a surgical microscope can assist accurate transection, transect the MMTL 

with a micro-surgical knife (sharppoint 15° 5 mm blade) to release the MM. 

Locating the patellar ligament first, this can assist the identification of the 

incision region.
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9. The sham group mice will be operated through the same approach without 

MMTL transection.

10. Close the incision together with a 9 mm wound forceps and clips.

11. To prevent joint infection, Amoxicillin (20 mg/kg) can be injected after surgery 

(optional).

12. Remove the clips with a wound clip remover after wound has healed.

3.2 Osteoarthritis (OA) Histological Grading

At 4 to 6 weeks (or at specific time point according to the experimental design) post DMM 

surgery, OA phenotypes can be graded or assessed by histological analysis, gene expression 

assay, microCT, pain behaviors, or gait analysis. Here we focus on the histological grading.

1. Collect knees from mice and arrange in a histological tissue cassette case (see 
Note 7).

2. To fix the tissue, place the tissue cassettes with mouse knees in 10% NBF for 48 

h at 4 °C. Rinse in DI water 3× for 10 min each time and store in 70% ethanol at 

4 °C.

3. To decalcify the samples, place the fixed tissues with cassettes in a beaker 

containing at least 15 volumes of 5% formic acid on a swirling/rocking platform 

for 7 days (see Note 8).

4. Rinse the tissues in DI water 4× for 10 min each time.

5. Dehydrate the tissues in 70%, 95%, and 100% ethanol for multiple rounds 1–2 h 

each (see Note 9).

6. Clear tissues in xylene for 1 h 2×.

7. Infiltrate tissues with paraffin (Paraplast X-tra) at 58 °C for 1 h 2×.

8. Embed tissues into wax blocks at 62 °C.

9. Rehydrate tissues for histology using xylene, absolute alcohol, 95% ethanol, 

80% ethanol, then rinse in distilled water (see Note 10).

10. Cut 5 mm sections of the tissues embedded in the blocks (see Note 11).

11. Bake the slides at 60 °C overnight and cool at room temperature for 20–30 min.

7.Sacrifice the mice in a CO2 chamber. Dissect both hind limbs from the hip of the mice using surgical scissors and tweezers. Remove 
about 1/3 of femur from the proximal end and 1/3 of the tibia from the distal end using surgical scissors. Straighten each knee and 
place in a labeled histological tissue cassette with the patella facing up. This will help the following embedding and sectioning in the 
frontal orientation.
8.Another common method for decalcification is incubation in 14% EDTA solution for 10 days. EDTA-decalcified tissues generally 
have better result for immunohistochemistry than formic-acid-decalcified ones. However, the Safranin O stain shows better color 
intensity on the formic-acid-decalcified sections.
9.Dehydrate the tissues in the following order: 70% ethanol for 1 h, 95% ethanol for 1 h, absolute ethanol for 1 h 2×, absolute ethanol 
for 1.5 h, and absolute ethanol for 2 h.
10.Deparaffinize sections, 2 changes of xylene, 3 min each, then rehydrate in 2 changes of absolute alcohol, 2 min each. Incubate in 
95% ethanol for 2 min followed by 80% ethanol for 2 min. Wash sections briefly in distilled water.
11.According to the recommendation of Osteoarthritis Research Society International (OARSI) [11], the knee joints should be 
paraffin-embedded in frontal orientation and sectioned through the entire joint at 80 mm interval. Each section should be 5 mm.
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12. Deparaffinize and hydrate in 70% ethanol and air dry.

13. Incubate the slides with Weigert’s Iron Hematoxylin for 30 min.

14. Wash the slides gently in running tap water for 10 min.

15. Differentiate by single dip in 1% acid-alcohol.

16. Rinse the slides in DI water 3×.

17. Incubate the slides with 0.08% Fast Green for 5 min.

18. Rinse the slides in 1.0% acetic acid for 10 s (blot, no rinse).

19. Incubate the slides in 1% Safranin O for 30 min (blot, no rinse).

20. Dehydrate the sections with 1 change of 95% ethanol and two changes of 100% 

ethanol by 1 dip each and air dry.

21. Clear the slides in xylene for 1 min, 2× and coverslip.

22. Score histologically to evaluate OA progression in a blinded manner following 

the semiquantitative scoring system established by Sonya S. Glasson et al. The 

OA phenotype of all four quadrants of joint, including the medial femoral 

condyle, medial tibial plateau, lateral femoral condyle, and lateral tibial plateau 

should be scored (see Note 12).

3.3 Imaging by Microcomputed Tomography

These methods have been adapted and optimized for use in our laboratories from several 

sources [7-9]. Methodology is specific to femurs from mice at 3–6 months of age. All 

microCT methods were performed under the recommended guidelines of the SkyScan 

software Standard Operating Procedures by Bruker MicroCT (Kontich, Belgium).

1. Fix limbs in 10% NBF for 48 h. Rinse limbs in deionized (DI) water and store in 

70% ethanol.

2. Prepare the limbs by wrapping them in gauze saturated in 70% ethanol. Load the 

limbs into a conical submerged in 70% ethanol while preventing air bubbles from 

entering. Samples should not be overlapping and should be snug in the container.

3. Turn the Skyscan 1172 on by turning key to “START” position. The key will 

automatically snap back into the “ON” position.

4. Open Skyscan 1172 software and start the X-ray tube by pushing the X-ray icon. 

A pop-up window will open with a progress bar as the tube ages. Once the X-ray 

is on, an indicator window will open.

12.The mouse OA knee damage categories followed by scores in parentheses include normal (0), loss of Safranin O with no structural 
changes (0.5), small fibrillations with no loss of cartilage (1), vertical clefts down to the layer immediately below the superficial layer 
and some loss of surface lamina (2), vertical clefts/erosion to the calcified cartilage extending to <25% of the articular surface (3), 
vertical clefts/erosion to the calcified cartilage extending to 25–50% of the articular surface (4), vertical clefts/erosion to the calcified 
cartilage extending to 50–75% of the articular surface (5), vertical clefts/erosion to the calcified cartilage extending >75% of the 
articular surface (6). Use mean value of the scores from the 4 quadrants of an individual knee joint for statistical analyses.
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5. Press the “grab image” icon to obtain a continuous preview from the X-ray 

camera and establish scan settings (see Note 13).

6. Perform a flat field correction (see Note 14).

7. Open the chamber on the scanner by pressing the “specimen door” icon, fasten 

the sample to a stage, and secure the stage on the rotation axis by turning the 

brass ring to tighten it.

8. Close the chamber by pressing the “specimen door” icon, turn the X-ray back on, 

and restore the settings established in step 5.

9. Set an oversize scan (see Note 15).

10. Select the “Start scanning” button in the Scout Scan window to open the settings 

dialog window and complete scan settings (see Note 16).

11. Click “OK” to start the scan.

12. After scanning is complete, open NRecon and load a dataset by choosing “Open 

Dataset” in the “Actions” tab and choosing one of the images from a scan. 

Choosing one image will open the entire dataset associated with the sample.

13. Perform a thermal correction (see Note 17).

14. Choose a dynamic range based on the histogram of the sample (see Note 18).

15. Correct beam-hardening (see Note 19).

16. Correct misaligned segments (see Note 20).

13.To establish settings, double-click the indicator window to open the X-ray energy settings. Set the voltage to 60 kV and current to 
167 μA. The “always maximize power” box should be checked, which will automatically adjust the power to 10 W and thus adjust 
voltage or current accordingly. Set the pixel resolution to 2000 × 1200 and the X-ray camera image pixel size to 6 μm. Apply a 0.5 mm 
aluminum filter.
14.Open “Preferences” in the “Options” tab. Un-check the two flat-field correction boxes and click “OK.” Select “Acquisition Modes” 
in the “Options” tab. Locate the window with the arrow which corresponds to the filter, camera position, and pixel size. Set the 
exposure to 360 and adjust the voltage and current windows if needed. Check the option, “Acquire bright + dark for current mode.” 
Grab image to obtain a live preview and right click to view the intensity profile. The average intensity should be ~60%. Note: If the 
average intensity is not ~60%, allow the X-ray to stabilize and adjust the exposure until it reaches ~60%. Open “Preferences” in the 
“Options” tab. Check the two flat-field correction boxes and click “OK.” The average intensity should be 88% (±2%).
15.Select “Set Oversized Scan” in the “Actions” tab. Click “Scout Scan” and allow the scan to run to the bottom of the stage. Enter the 
sample name in the “Prefix” window. Select the “Top” button and click the top of the sample, followed by the “Bottom” button and 
click the bottom of the sample. Repeat this process for each sample in the scout scan preview window.
16.Designate a file location by choosing “Browse” and select a location. Set rotation step (deg.) to 0.4, averaging (frames) to 5, 
random movement to 10. Un-check the following: use 360-degree rotation, open chamber after scanning, camera offset and partial 
width. Check “X-Ray off after scanning.”
17.Select “X/Y alignment with a reference scan” under the “Actions” tab. Move the adjustable box to cover the sample. Adjust the 
“Max. x-shift from start point (+−)” and “Max. y-shift from start point (+−)” to 20. Change the “Matching criteria and method” to 
“Least-Square.” Change the “Projection pairs to match” to “All.” Click “Match,” and after the application is complete, click “Accept.”
18.In the “Start” tab, select the area in the sample to preview. For a mouse femur, there will be multiple segments. Select “Preview.” In 
the “Output” tab, change the graph to log view. To toggle between graphs, double-click the graph. Click the tab underneath the 
histogram and set the minimal value to 0. Adjust the maximal value, indicated by the red line, by dragging the line and placing it just 
after the peaks from the dataset end. Use this dynamic range for the rest of the samples in the project.
19.In the “Output” tab, right click and drag over a nonporous part of a sample. This will open an absorbance vs. distance graph. This 
works best when using cortical bone. Record the shape of the graph (cupping indicates beam-hardening, arching indicates over-
correction of beam-hardening, and flat indicates little to no beam hardening). Repeat two or three times in different proximal and 
distal regions of the sample. Click on the “Settings” tab and perform the necessary corrections for each graph type (increase the beam-
hardening correction percentage for cupping, decrease the beam-hardening correction percentage for arching, and no further correction 
needed for flat graphs). Adjust beam-hardening settings until the graphs become flat. The same beam-hardening settings are used for 
the rest of the samples in a project. For a mouse femur, this number typically ranges from 20% to 40%.
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17. Reduce ring artifacts (see Note 21).

18. Smooth the images (see Note 22).

19. Choose a region of interest (ROI) to save (see Note 23).

20. Choose a volume of interest (VOI) to save (see Note 24).

21. Reconstruct and save the images (see Note 25).

22. After the images have been reconstructed, open Data Viewer and load a 

reconstructed dataset from a “Rec” folder of a sample.

23. After the sample is open, click the “load for 3D viewing” icon.

24. Use the three views to straighten the sample. Orient all samples in a project the 

same way.

25. Under the “View” tab, choose “Single Volume of Interest (VOI),” and fit the 

sample within each of the boxes to crop the dataset and define a volume of 

interest (VOI).

26. Save the volume of interest (see Note 26).

3.4 Bone Mineral Density Calibration

1. Scan, reconstruct, and orient the bone mineral density standards following the 

steps under “Imaging by Microcomputed Tomography 3.3.”

2. Open the CTan software and load one of the density standards by choosing the 

“open image or dataset” icon.

3. Define the upper bound of the density standard by scrolling to the top and 

choosing a slice that includes the entire density standard. Right click the slice in 

20.In the “Start” tab, select an area in the sample and click the “Fine Tuning” button and select “Post-alignment.” Set number of trials 
to 5 and set parameter steps to 0.5 or 1. Click “Start” and refer to the “Output” tab. Toggle through the choices using the arrow buttons 
and choose an option that minimizes changes in pores, edges, and dense particles. If the fine tuning does not work in the range 
selected, manually change the misalignment compensation in the “Settings” tab. Repeat fine tuning for each part of the sample (there 
should be 3 or more segments for a mouse femur).
21.In the “Settings” tab, check “Ring Artifacts Reduction,” and set to 10. In the “Start” tab, select an area in the sample, click the 
“Fine Tuning” button, and select “Ring Artifacts Reduction.” Set number of trials to 5 and set parameter steps to 5 Click “Start” and 
refer to the “Output” tab. Toggle through the choices using the arrow buttons and choose an option that best reduces ring artifacts. This 
will only be done once per sample.
22.This application should only be used if there is noise in the background of the scan, which can be viewed in the “Output” tab. To 
turn on smoothing, click the “Settings” tab and check the “Smoothing” box. Adjust the levels until the noise in the background is 
canceled. To see the effect of smoothing, choose the “Start” tab, select an area in the sample and click “Preview.” Use the same 
smoothing settings for the rest of the samples in a project.
23.In the “Start” tab, select an area in the sample to view and click “Preview.” In the “Output” tab, check “Use ROI,” and choose a 
shape. Move and adjust the size of the ROI in the preview window so that the sample is inside the ROI. Expand the ROI in different 
segments of the femur to confirm the whole sample is within the ROI (from proximal to distal epiphysis).
24.Choose the “Start” tab to see an overview of the scan. Move the red lines at the top and bottom of the scan to include the area of 
interest.
25.There are two ways to reconstruct and save the images. Option 1: Choose the “Start” tab and click the “Start” button. Option 2: 
Choose the “Start” tab and click the “Add to batch button.” Continue to load more datasets to the batch by choosing the “Add to batch 
button” after reconstructing each sample. When all datasets are complete, click “Start Batch” in batch manager. Folders with 
reconstructed files will appear in the scan folders.
26.Under the “Actions” tab, choose “Save” and “Select a VOI to Save.” Establish settings in the “Options for saving a VOI” window 
under “Saving options.” In the Resize X/Y option, choose 1. In the View to save option, choose Transaxial (X-Y). Create a new VOI 
folder within the reconstruction folder. Click “OK” to save the VOI.
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the dataset window and choose “Set the Top of Selection.” Repeat for the lower 

bound but choose “Set the Bottom of the Selection.”

4. Define the region of interest (ROI) to include only the density standard (see Note 

27).

5. Save the ROI (see Note 28).

6. Open the new ROI file for the density standard by selecting the “open image or 

dataset icon” and choosing one of the images in the ROI folder.

7. Apply the ROI to the open file (see Note 29).

8. Identify and record the attenuation coefficient (see Note 30).

9. Repeat steps 2–8 for the other density standard.

10. Under “File,” choose “Preferences,” and under the “Histogram” tab, choose 

“Calibrate.”

11. Enter the known min and max BMD density values of the density standards (Ex: 

0.25 and 0.75) followed by the corresponding attenuation coefficients recorded in 

step 8.

12. Click “OK” to calibrate the density range.

3.5 Trabecular Analysis of Microcomputed Tomography Images

1. In the CTan software, select the “open image or dataset” icon. Choose a dataset 

within a newly created VOI folder.

2. Identify the reference point for the ROI, use a 0.25 mm offset, and create an ROI 

2.5 mm in height (see Note 31).

3. Create a region of interest to include trabecular bone only, by manually drawing 

an ROI (see Note 32) or use an automated program and save the regions. If 

manually drawing ROIs, continue to step 6 after this step. To make an automated 

program to create an ROI, continue to step 4.

4. Begin the automated trabecular ROI process by, saving the ROI defined in step 2 
and determining the thresholding scale (see Note 33).

27.Select the “regions of interest preview” icon. Select the “interpolated region of interest” drop-down menu. Select “Round.” Adjust 
the circle so that it is slightly smaller than the density standard and place it in the center of the density standard.
28.Under “File,” choose “Save from ROI.” Create a new ROI folder and un-check “Create folder named VOI.” Check “Save ROI-file” 
and click “OK” to save the ROI file.
29.Select the “regions of interest preview” icon followed by the “load regions of interest” icon. Open the “.roi” file.
30.Select the “binary selection preview” icon. Select the “From dataset” tab in the “Histogram” window. Select the “Attenuation 
coefficient” tab. Scroll to the bottom and record the mean (total).
31.Scroll through the images to locate where the growth plate separates. In the dataset window right click the slice chosen and click 
“Selection Reference.” Double-click the black bar in the dataset window to open the “Selection” window. Under the “Analytic” tab set 
offset 0.25 mm and height to 2.5 mm.
32.To manually draw an ROI, choose the “regions of interest preview” icon. Scroll to the lower boundary of the ROI and draw a region 
that includes trabecular bone but excludes the growth plate and cortical bone. Scroll toward the upper boundary of the ROI and 
continue drawing skipping several images in between. The ROIs drawn will interpolate automatically. To save, choose “Save from 
ROI” under the “File” tab. Create a new folder for the trabecular ROI and un-check “Create Folder named VOI” and check “Save ROI-
file.” Click “OK” to save the ROI.
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5. Open the ROI saved in step 4 by choosing the “open an existing image or 

dataset” icon and choosing an image within the ROI folder for the sample. Build 

a task list to create, analyze, and save an automated trabecular ROI (see Note 

34). After building the task list, skip to step 9.

6. Open a sample’s manual ROI by choosing the “open an existing image or 

dataset” icon and choosing an image within the trabecular ROI folder for the 

sample.

7. Apply the manual ROI to the open file and determine the thresholding scale (see 
Note 35).

8. Choose the “custom processing preview” icon and select the “Internal” tab to 

build a task list to analyze the trabecular bone (see Note 36).

9. Run the task list on multiple samples using the batch manager (see Note 37).

33.Save the ROI by choosing “Save from ROI” under the “File” tab. Create a new folder for the trabecular ROI. Uncheck “Create 
Folder named VOI” and check “Save ROI-file.” Click “OK” to save the ROI. To determine the thresholding scale, select the “binary 
selection preview” icon. Select the “From dataset” tab in the histogram window. Choose the “automatic thresholding” icon in the 
histogram window. Record the upper and lower threshold values. For a project, the thresholds for all samples should be recorded and 
then averaged.
34.To build a task list to create a trabecular ROI and run analysis, select the “custom processing preview” icon and select the 
“Internal” tab to build a task list. Click + to add a function to a task list. Do not run the task list yet. Add the functions in the following 
order with the described settings: thresholding (Global—enter the values determined in step 4), despeckle (type: sweep, 3D space, 
remove: all except largest object, and apply to: image), ROI shrink-wrap (mode: shrink-wrap, 2D space, check “stretch over holes,” 
diameter: 32 pixels—adjust as needed), bitwise operations (image = image XOR region of interest), morphological operations (type: 
opening, 3D space, kernel: round, radius: 2, and apply to: image), morphological operations (type: closing, 3D space, kernel: round, 
radius: 2, and apply to: image), morphological operations (type: opening, 3D space, kernel: round, radius: 4, and apply to: image), 
morphological operations (type: closing, 3D space, kernel: round, radius: 4, and apply to: image), morphological operations (type: 
opening, 3D space, kernel: round, radius: 6, and apply to: image), morphological operations (type: closing, 3D space, kernel: round, 
radius: 6, and apply to: image), morphological operations (type: opening, 3D space, kernel: round, radius: 8, and apply to: image), 
morphological operations (type: closing, 3D space, kernel: round, radius: 8, and apply to: image), morphological operations (type: 
opening, 3D space, kernel: round, radius: 9, and apply to: image), morphological operations (type: closing, 3D space, kernel: round, 
radius: 9, and apply to: image), morphological operations (type: opening, 3D space, kernel: round, radius: 10, and apply to: image), 
morphological operations (type: closing, 3D space, kernel: round, radius: 10, and apply to: image), morphological operations (type: 
erosion, 2D space, kernel: round, radius: 3, apply to: image), bitwise operations (region of interest = COPY Image), reload (apply to: 
image), despeckle (type: sweep, 2D space, remove: all except largest object, apply to: region of interest), despeckle (type: remove 
pores, 2D space, detected: by image borders, apply to: region of interest), save bitmaps (apply to ROI, file format: BMP, check 
“custom sub-folder” and name the folder, check “convert to monochrome” 1 bit), histogram (unit: bone mineral density, choose 3D 
space, check “Inside VOI,” choose a file name and location), thresholding (global thresholding, use the values previously recorded for 
thresholding), despeckle (remove white speckles, choose 3D space, volume: less than 6 voxels, apply to image), despeckle (remove 
black speckles, choose 3D space, volume: less than 6 voxels, apply to image), 3D analysis (check “basic values,” “additional values,” 
“trabecular thickness” and “trabecular separation,” under the “save results as” region, select a format to save the data output, and name 
the output of the dataset), and 3D model (apply to: image inside ROI, type of file: *.p3g, algorithm: Double-Time Cubes, check 
“Custom filename” and name the file).
35.To apply the ROI to the open file, select the “regions of interest preview” icon. Select the “load regions of interest” icon and open 
the “.roi” file. To determine the thresholding scale, select the “binary selection preview” icon. Choose the “From dataset” tab in the 
histogram window and select the “automatic thresholding” icon in the histogram window. Record the upper and lower threshold 
values. For a project, the thresholds for all samples should be recorded and then averaged.
36.To add functions to a task list, click + on a highlighted function. Add the following functions to the task list in the following order 
with the described settings: histogram (unit: bone mineral density, choose 3D space, check “Inside VOI,” choose a file name and 
location), thresholding (global thresholding, use the values previously recorded for thresholding), despeckle (remove white speckles, 
choose 3D space, volume: less than 6 voxels, apply to image), despeckle (remove black speckles, choose 3D space, volume: less than 
6 voxels, apply to image), 3D analysis (check “basic values,” “additional values,” “trabecular thickness” and “trabecular separation,” 
under the “save results as” region, select a format to save the data output, and name the output of the dataset), and 3D model (apply to: 
image inside ROI, type of file: *.p3g, algorithm: Double-Time Cubes, check “Custom filename” and name the file).
37.Select the “BATMAN” icon. Choose the “Add” button and load a trabecular ROI dataset (from step 3 if manual method was used 
and step 4 if automated method was used). Under the “Add” arrow button, choose “Load ROI” and select the “.roi” file. Add all 
samples within a project and click “Start” to run the task list on all samples.
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3.6 Cortical Analysis of Microcomputed Tomography Images

1. In the CTan software, select the “open image or dataset” icon.

2. Identify the reference point for the ROI and set the height to0.6 mm (see Note 

38).

3. Create a region of interest to include the entire area of the bone (see Note 39).

4. Save the cortical ROI (see Note 40).

5. Open a sample ROI by choosing the “open an existing image or dataset” icon 

and choosing an image within the cortical ROI folder for the sample.

6. Apply the ROI to the open file and determine the thresholding scale (see Note 

41).

7. Build a 2D analysis task list using a combination of functions until the cortical 

bone that remains in the “binary selection preview” closely matches the raw 

images (see Note 42).

8. Build a histogram Task List by constructing a task list the same as the “2D 

analysis Task List” except for the 2D analysis and 3D model functions. Add ROI 

shrink-wrap, reload, histogram functions to the end of the list (see Note 43).

9. Run the task list on multiple samples using the batch manager. Repeat for each 

task list (see Note 44).

38.To define a reference point, first select the “regions of interest preview” icon. Define the length of the bone by using the Z-position 
in the “Dataset” window and calculate 45% of the femur’s length. Move the distance calculated from the distal end of the femur. 
Select the slice in the “Dataset” window. To make the position the selection reference, right-click and choose “Selection Reference.” 
Double-click the black bar in the dataset window to open the “Selection” window. Under the “Analytic” tab set offset 0 mm and height 
to 0.6 mm.
39.At this location in the diaphysis, mostly cortical bone remains. To create an ROI that contains the cortical bone, start by choosing 
the “regions of interest preview” icon. Scroll to the lower boundary of the ROI. Click the “interpolated region of interest” dropdown 
and choose “Elliptic.” Include the entire area of the bone within the ellipse. Scroll toward the upper boundary of the ROI and continue 
moving the ellipse to cover the entire tissue, skipping several images in between. The ellipses will interpolate automatically.
40.To save the cortical region of interest (ROI) choose “Save from ROI” under “File.” Create a new cortical ROI folder. Uncheck 
“Create folder named VOI” and check “Save ROI-file.” Click “OK” to save the ROI.
41.To apply an ROI, select the “regions of interest preview” icon. Select the “load regions of interest” icon and open the “.roi” file. To 
determine a thresholding scale, start by selecting the “binary selection preview” icon. Select the “From dataset” tab in the histogram 
window. Choose the “automatic thresholding” icon in the histogram window. Record the upper and lower threshold values. For a 
project, the thresholds for all samples should be recorded and then averaged.
42.Choose the “custom processing preview” icon and select the “Internal” tab to build a task list. Add the following functions to the 
task list in the order with the described settings: thresholding (global threshold, use values recorded from step 6), despeckle (remove 
white speckles, choose 3D space, volume: less than 6 voxels, apply to image), despeckle (remove black speckles, choose 3D space, 
volume: less than 6 voxels, apply to image), ROI shrink-wrap (mode: shrink-wrap, 2D space, check “stretch over holes,” choose 
appropriate number of pixels for phenotype for diameter, morphological operations and bitwise operations (use a combination as 
needed to rid the sample of any trabecular bone so that only cortical bone remains), despeckle (use in between morphological 
operations as necessary to rid the region of trabecular bone, type: sweep, 2D or 3D space depending on sample, remove: all except 
largest object, apply to: image), 2D analysis (under the “add to report” region choose “all results,” check “Append Summary results to 
file,” and choose a file name and location), and 3D model (apply to: image inside ROI, type of file: *.p3g, algorithm: double-time 
cubes, check “custom filename” and name the file).
43.Add the following functions to the end of the task list in order with the described settings: ROI shrink-wrap (mode: shrink-wrap, 
3D space to ensure that only the bone will be measured when calculating BMD, check “stretch over holes,” diameter: choose 
appropriate number of voxels for phenotype), reload (apply to: image), and histogram (unit: bone mineral density, 3D space, check 
“Inside VOI” and “Append Summary results to file,” and choose a file name and location).
44.To use Batch Manager, select the “BATMAN” icon. Choose the “Add” button and load a cortical ROI dataset. Under the “Add” 
arrow button, choose “Load ROI” and select the “.roi” file. Load all samples within a project and click “Start” to run the task list on all 
samples.
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3.7 Modeling Skeletal Phenotypes

Several modifications can be made when generating visual representations of scanned 

samples. The guidelines below are for a basic, gray-scale model.

1. Using CTvol, open a 3D file by selecting the “open 3D object” icon and 

choosing the p3g file within the ROI folder of the desired sample.

2. Use the wheel on the computer mouse to zoom in and out on the sample.

3. Select “Options” and choose “Objects” to open up the “Objects” window. Adjust 

color, emission, diffusion, reflection, and opacity as desired within this window.

4. Select the “move camera” or “move objects” icon and use your mouse to adjust 

the sample to the desired position and angle.

5. Save the Image by selecting “Save Image” from the “File” dropdown menu.

3.8 Mouse Fluorochrome Injections

Labeling schedules will vary depending on anticipated phenotype and project design. The 

following schedule is for mice 6 months of age with fluorochrome labeled surfaces at four 

different time points.

1. At 4 weeks of age, perform intraperitoneal (IP) injections on mice with 0.10% 

working calcein solution. Inject 0.2 mL per 20 g of body weight for a 10 mg/kg 

dose (see Note 45).

2. At 10 weeks of age, perform IP injections on mice with 0.20% working alizarin 

complexone solution. Inject 0.2 mL per 20 g of body weight for a 20 mg/kg dose 

(see Note 45).

3. At 24 weeks of age, perform IP injections on mice with 0.75% working 

demeclocycline hydrochloride solution. Inject 0.250 mL per 20 g mouse 150 

IP/100 subcutaneous for a 75 mg/kg dose (see Note 45).

4. At 25 weeks of age, perform IP injections on mice with 0.10% working calcein 

solution. Inject 0.2 mL per 20 g of body weight for a 10 mg/kg dose.

5. Sacrifice animals at 26 weeks of age.

3.9 Infiltration

1. Fix the femurs in 10% NBF for 48 h, followed by storage in 70% ethanol.

2. Remove excess tissue from femurs and move to individual histocassette tissue 

cassettes.

3. Using the Dremel hand tool, notch each bone ¼ to ½ of the way through in the 

midshaft region. Return each bone to its cassette.

4. Dehydrate and clear the samples for 2–4 h in 70% ethanol, 95% ethanol, 100% 

ethanol, and xylene (see Note 46).

45.To minimize complications with IP injections, dosage can be split between IP and subcutaneous injections.
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5. Transfer the specimens to xylene until infiltration.

6. Within the RIP unit infiltrate the samples under 15 psi using 100% MMA for 24 

h (infiltration 1), the infiltration solution for 24 h (infiltration 2), followed by the 

infiltration solution for at least 2 days (infiltration 3).

7. Transfer bone tissue to individual, prefabricated embedding molds for coronal 

sectioning or glass culture tubes for cross-sectioning.

3.10 Femoral Embedding and Cross-Sectioning—When processing tissues that are 

light sensitive due to fluorochrome labeling, keep in the dark in between processing steps.

1. Add a few drops of glass culture tube embedding solution into a labeled glass 

culture tube and insert the femur, ensuring the head of the femur is closest to the 

open end of the tube (see Note 47).

2. Cap the glass tube with a rubber stopper and transfer the beaker into the bead 

bath at 25 °C for optimal polymerization.

3. Check the glass tubes once daily until the polymerization process is complete 

(see Note 48).

4. Remove the polymerized rod containing the femur from the glass culture tube by 

gently shattering the surrounding glass.

5. Load the resulting plastic rod into the specimen holder of the Extech Labcut 150. 

Secure the rod into the specimen holder by tightening down the adjustment bolts 

with an Allen wrench.

6. Line up the plastic rod with the diamond wafering blade to the midshaft of the 

femur and move the specimen arm so it sits at the back of the Labcut 150.

7. Place either the unattached reed switch magnet or the canopy in place so that the 

reed switch is covered.

8. Turn the instrument on, set the speed to 166.2 rpm, select the “rev” button to start 

the blade.

9. Turn on the lubricant pump and slowly pull the specimen arm forward.

10. Sit the rod atop the saw blade and begin to section the bone at the midshaft or 

slightly more distal (see Note 49).

11. Save the distal end for MMA embedding and coronal cross- sectioning or discard 

it.

46.In a tissue processor, in order, clear the samples for 2–4 h each, in the following solutions: 70% ethanol, 95% ethanol 2×, 100% 
ethanol 3×, and xylene 2×.
47.Add a paper label containing the specimen ID to the end of the tube. Fill the remainder of the tube with embedding solution until 
the tube is approximately ¾ full.
48.Monitor the volume of embedding solution for evaporation and add additional embedding solution to ensure the samples remain 
submerged, when necessary. Polymerization is complete when the embedding solution has turned to a hardened plastic, the tube is 
smooth, and no longer tacky.
49.When the saw blade cuts completely through the rod, the saw blade will automatically stop as it sits on the specimen arm.
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12. Adjust the micrometer on the Extech Labcut 150 with the diamond wafering 

blade to the desired thickness for the first wafer. Ensure the rod is advancing over 

the blade (see Note 50).

13. Section desired number of wafers.

14. Remove any plastic dust particles from the wafers by dipping each in a sonicator 

filled with deionized water for 3–5 s. Dab off any excess water.

15. Place a nickel size pool of Eukitt mounting media onto the back of a labeled 

glass slide and mount the wafers in the pool.

16. Cover the glass slide with 2–3 layers of 1–2 ply paper towel cut into slide size 

strips.

17. Place a blank glass slide on top of the paper towel strips and fasten both slides 

together with 2–3 binder clips and allow the slide to air dry overnight.

18. Remove the binder clips, blank slide, and paper towel strips from the surface of 

the slide with mounted wafers to be sanded.

19. Using a table micrometer, zero out the slide thickness by placing a portion of the 

glass slide that does not contain a wafer between the clamps. Tighten the clamp 

on the slide and clear the counter.

20. Open the micrometer clamp and move the slide so one of the mounted wafers is 

measurable. Close the clamp down onto the wafer and obtain a starting 

measurement of the wafer. Repeat this step for all wafers.

21. Using 600 grit sandpaper, gently sand the surface of the wafers until each 

measures 40–50 μm. Remeasure each wafer using the micrometer throughout the 

sanding process in order to determine when the desired thickness has been 

obtained.

22. Once all wafers have been sanded to the desired thickness, wipe the sanding 

remnants from the surface of the slide with a damp paper towel.

23. Add a thin layer of Eukitt mounting media to the surface of the wafers and add a 

glass coverslip.

24. Add 2–3 small weights to the top of the coverslip to ensure any air bubbles are 

removed and allow the slides to air dry overnight.

3.11 MMA Embedding and Coronal Sectioning of Femurs—When processing 

tissues that are light sensitive due to fluorochrome labeling, keep in the dark in between 

processing steps.

1. Add a thin layer of prefabricated mold embedding solution to each prefabricated 

mold and allow the reagent to become sticky/tacky.

50.Example: a 15 mm setting on the micrometer will yield a 35 μm wafer.
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2. Orient the tissue for coronal sectioning and fill remainder of the mold with 

prefabricated mold embedding solution.

3. Add a paper label containing the specimen ID, and a paper clip bent to a 45°−90° 

angle to each mold.

4. Cap the top of the mold with a silicone stopper and transfer each mold to the 

bead bath at 25 °C, ensuring the containers are covered.

5. Remove molds from the bead bath daily and check until polymerization is 

complete (see Note 51).

6. Remove fully polymerized molds to grind and polish using the MetaServ 250 

Single Grinder/Polisher (see Note 52).

7. Apply a thin layer of the coating solution to a glass slide.

8. Place the embedded tissue mold in the microtome chuck and face into the mold 

until the desired tissue is exposed.

9. Brush the exposed face of the block with a fine tip paint brush, soaked in the 

cutting solution, and initiate the automatic microtome to begin slicing a section 

from the block at 5 μm.

10. Cut a small rectangle from a Kimwipe, and soak in 70% ethanol.

11. Apply the Kimwipe to the surface of the mold and initiate cutting on the 

microtome at a very slow speed.

12. As the Kimwipe and plastic section are slowly cut, grasp them together with a 

pair of forceps. Continue to carefully pull the section off the block as it is cut 

away by the microtome.

13. Transfer the section and wipe into a petri dish of 75% ethanol. Carefully stretch 

the section if wrinkles are visible using two pairs of forceps.

14. Once flat, place a piece of plastic film, just larger than the section, on top of the 

section to keep it free of wrinkles.

15. Transfer the section and plastic film combination to the coated slide.

16. Cover the slide with a thin sheet of plastic and lightly squeeze out any excess 

ethanol using a gentle wiping motion with a Kimwipe.

17. Cover the section with paper towel and roll flat with rubber roller.

18. Each day sectioning is completed, stack the slides together with a blank slide on 

the top and bottom of the stack and place in a clamp. Transfer each stack to an 

oven set at 60 °C, overnight.

19. Remove slides from the oven and inspect for damage.

51.Polymerization is complete when the embedding solution has turned to a hardened plastic, the mold is smooth, and no longer tacky.
52.Expose the surface of the polymerized block using the grinder by holding the back of the block so that the face is in contact with 
the abrasive paper. While the block is still wet, apply pressure as needed and rotate the paper to polish away the surface of the mold.
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20. Begin deplasticizing slides by soaking them in cellusolve for 1 h.

21. Place slides in acetone for 2–5 min.

22. Rinse slides in DI water for 2–5 min.

23. Continue to “Goldner’s Trichrome Staining 3.12” step 1 for staining or step 10 
to only coverslip for fluorochrome imaging.

3.12 Goldner’s Trichrome Staining

1. After deplasticizing samples, place slides in Wiegerts Hematoxylin for 20 min.

2. Rinse slides in running Tap Water for 10 min.

3. Place slides in working solution of Ponceau Acid Fuchsin for 10 min.

4. Place slides in 1% acetic acid for 30 s.

5. Place slides in filtered PTA-Orange G for 4 min.

6. Place slides in 1% acetic acid for 30 s.

7. Place slides in Light Green solution for 10 min.

8. Place slides in 1% acetic acid for 1 min.

9. Rinse slides in 2 changes of distilled water, for 1 min each.

10. Coverslip using the Ventana Symphony by using the proprietary “Coverslip 

Only” program.

3.13 Paraffin Embedding and Sectioning of Femurs

1. Fix the femurs in 10% NBF for 48 h, followed by storage in 70% ethanol.

2. Remove excess tissue from femurs and move to individual histocassette tissue 

cassettes.

3. Decalcify samples in 10% EDTA pH 7.4, stirring for 10–14 days at 4 °C (see 
Note 53).

4. Dehydrate, clear, and infiltrate the samples in cassettes within a tissue processor 

using 70% ethanol for 60 min, 80% ethanol for 60 min, 95% ethanol for 60 min 

2×, 100% ethanol for 60 min 3×, xylene for 30 min 2×, paraffin for 30 min, and 

paraffin for 45 min.

5. Remove the cassettes from the tissue processor and move them to the embedding 

center.

6. Set the heated areas of the embedding center between 60 °C and 70 °C.

7. Remove the tissue from the cassette and place it in an appropriately sized heated 

mold. Orient all the samples the same way depending on the type of cut desired 

(sagittal or coronal).

53.Replace with fresh EDTA after 7 days. Samples should be flexible before processing.

Foxa et al. Page 20

Methods Mol Biol. Author manuscript; available in PMC 2021 March 05.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



8. Hold the tissue specimen down with forceps while partially filling the mold with 

molten paraffin. Secure the tissue by quickly cooling the base of the mold (see 
Note 54).

9. Place the cassette bottom atop the mold and fill with paraffin.

10. Cool the blocks in a cooling area to set the paraffin until it has solidified.

11. Remove the blocks from the mold by pulling upward on the cassette.

12. Rough cut/face each block to expose the desired surface area of the tissue(s). 

Precool paraffin blocks with the tissue side down in a tray of ice water to 

facilitate sectioning.

13. Using a steel microtome knife or disposable blade, cut the appropriate sections 

(see Note 55).

14. For histological sections, place the sections on the pre-labeled glass slides with 

the IDs that correspond to each block being sectioned. Mount sections by 

floating a paraffin ribbon into a water bath set between 36 °C and 42 °C.

15. Dry paraffin sections in a lab oven set to 60 °C for 10–20 min.

16. Remove the sections from the oven and allow the slides to cool at room 

temperature.

17. Deparaffinize slides by soaking in fresh xylene for 3 min 3×, hand-dip slides into 

100% ethanol 10×, repeat in fresh 100% ethanol, hand-dip slides in 95% ethanol 

10×, repeat in fresh 95% ethanol, and rinse in DI water.

18. Store slides in DI water until TRAP staining.

3.14 TRAP Staining

1. Use the Sigma-Aldrich product 387-A: Acid Phosphatase, Leukocyte (TRAP) kit 

and protocol to stain deparaffinized samples.

2. Coverslip the slides using an aqueous mounting media and glass coverslips.

3.15 Imaging Slides

1. Image the trichrome stained samples at 20× magnification using a brightfield 

microscope (Leica Aperio AT2—High Volume, Digital Whole Slide Scanning).

2. Image fluorochrome labeled samples at 20× magnification (Zeiss Axio 

Imager.A2, Lumen Dynamics X-Cite Series 120 Q, QImaging QIClick Digital 

CCD Camera) using objective filter ET-DAPI/FITC/Texas Red (Chroma product 

# 69002). Use BIOQUANT OSTEO 19.2.6 software and follow the BIOQUANT 

OSTEO 19.2.6 “Image Region and Image Menu Introduction.”

54.To prevent cross-contamination, wipe the forceps with a clean Kimwipe prior to placing them back into the forceps warmers.
55.For histological sections, 5 μm is the standard thickness.
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3.16 Histomorphometry—The analysis steps are specific to BIOQUANT OSTEO 

19.2.6 Manual.

1. To quantify trabecular bone parameters, open BIOQUANT OSTEO 19.2.6 

software and create a new dataset following “The Data Region: Introduction.”

2. Measure trabecular parameters (Goldner’s Trichrome stained, Fluorochrome 

labeled, TRAP stained slides) by following the “Rodent Trabecular Bone 

Protocol.”

3. To quantify cortical bone parameters, start by creating new dataset following 

“The Data Region: Introduction.”

4. Measure cortical bone parameters by following the “Basic Cortical Bone 

Protocol.”
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